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1 Forward

This manual is intended to provide a means of reproducing the materials, parts, and testing
techniques and data of the Cummins Active Noise Control Senior Design Project. More
detail about the basics and design of the project can be found in the Final Design document
associated with this Senior Design Project. However, it is noted that this is a general
overview and not a certified operations manual. Always refer to the provided safety and
operation manuals for specific equipment used or mentioned in this manual for more
comprehensive instructions. Also, due to the hazardous nature of certain testing equipment,

use caution and heed any safety instruction provided by product manufacture.

The techniques listed in this manual were chosen due to limitations mainly including existing
equipment, equipment availability, and project budget. Other means of replicating preformed
tests are available. This manual’s intention is to present at the least a method to make a solid

comparison for the user.



2 Warnings

Due to the electrical and high magnetic fields of certain materials and testing equipment,
safety precaution must be made while operating or handling these objects. Throughout this
manual, a yellow lightning bolt, shown below, indicates a safety warning that should be

noted prior to proceeding to the next step.

A

Figure 2-1: Warning Symbol



3 Design Description and Assembly

3.1 Prototype Design

The prototype design consists of seven main parts; the gear housing, gear cover, MFC
actuators, Vibrablock perimeter extrusion, sound barrier panel, sound absorbing foam, and
the associated bolts and washers. These components, with the exception of the MFC
actuators, are essentially a bottom up bolt on assembly. The MFCs require an adhesive for
attachment and also wiring due to their electrical needs. Please refer to Figure 3-1 for an

exploded diagram of the assembly.

Figure 3-1: Exploded Assembly View



3.2 Assembly Instructions

3.2.1 MFC Wiring and Application

1) Determine the positioning of the MFC actuators. For the mentioned project, the
MFCs are oriented in the direction of the propagated vibrations, i.e. towards the

center nodal point. Please refer to Figure 3-2 and A1 for clarification.

Figure 3-2: MFC orientation on scale model cover

2) Using a graphite or grease pencil and a cardboard cut-out stencil of the MFC, mark

the top side of the gear cover for positioning reference. See Figure 3-3.



3)

4)

5)
6)

Figure 3-3: MFC, MFC cutout, and stencil marking

Always use an oven glove or some type of heat rated hand protection when using a

heat oven or the like.

Pre-heat a heat oven or vacuum oven to 50°C to 60°C, if available. Using a heat oven

is not necessary, but recommended.
When using strong adhesives, it is recommended to use safety gloves.

Apply adhesive, 3M DP 460, sparingly to the underside of the MFC using applicator
gun and mixing nozzle.
Press MFC upon the gear cover, positioning it inside the reference lines.

Apply moderate force to the MFC to squeeze the adhesive from the inside out

heeding caution to air bubbles.



7) Wipe excess adhesive away using cotton swabs.

8) Repeat Steps 4) - 7) for remaining MFC patch actuators.

9) Carefully place gear cover inside heat oven.

10)  Place small weights on top of each patch actuator being careful to avoid touching
excess adhesive.

11)  The MFCs have the tendency to shift for the first 10-20 minutes, so pay close
attention to the patch actuators’ orientation and re-position if necessary.

12)  Let MFC actuators cure inside the heat oven for two hours.

13)  Remove gear cover from heat oven and allow to cool for at least half an hour.

14)  Begin wiring the MFC actuators by pre-cutting black and red 16 awg wire to lengths
of about three feet. See Figure 3-4.

s : 2 A S ¥

Figure 3-4: Red and black 16 awg wire and wire stripping tool

15)  Using a wire stripper, strip the ends of each piece of wire.



16)  Match the black wires with the negative contact areas and the red wires to the positive

contact areas. See Figure 3-5.

Figure 3-5: MFC positive and negative contact patches

17)  Using soldering flux and soldering iron, solder the bare wire end to the bare contact
area on the MFC.
18)  Position and organize the wires neatly out of the way.

20)  Use same process of applying the MFCs for structures such as the cantilever beam.



3.2.2 Model Assembly

1) If assembling scale model with MFC patch actuators, follow section 3.2.1 to apply
MFCs prior to proceeding to the next step. See Figure 3-2.

2) Cut Vibrablock to go around the perimeter of the scale model cover; it should be
about half an inch wide all around.

3) Using a '4” hole punch or drill fitted with a 4” drill bit, punch holes through the
vibrablock in the same locations where holes exist on the scale model cover. See Al.

4) Peel back the clear plastic backing to expose adhesive side and place Vibrablock

washer layer on top of the scale model cover. See Figure 3-6.

Figure 3-6: Vibrablock washer layer placed on top of cover

5) Place a small bead of RTV sealant along the top of the scale model housing. See
Figure 3-7.
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Figure 3-7: Scale model housing with black RTV sealant

6) Before the RTV dries, place the bottom of the scale model cover on top of the scale
model housing. See Figure 3-8.

Figure 3-8: Scale modeling cover positioned above scale model housing
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7) Using 4”-20 button head socket cap screws, screw down the scale model cover to the

housing; make sure to only use eight of these screws in the correct inside hole

locations. See Figure 3-9 and Figure 3-10.

Figure 3-9: Alignment of screw with cover and housing.

Figure 3-10: Correct locations for button head screws.
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8) Cut additional layers of Vibrablock like in step 2) but also cut notches at the 13 hole
locations for head clearance; four layers are needed for button head screws.

9) Peel off protective backing from Vibrablock and stack each layer on top of each
other, placing the first on top of the Vibrablock washer layer in step 4). See Figure 3-
11.

Figure 3-11: Four layers of Vibrablock stacked on top of each other.

10)  Screw down the five “keyed” '4”-20 threaded rod links into the outside corner holes

about '4”. See Figure 3-12 and Figure 3-13.
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Figure 3-12: Insertion of keyed 4”-20 threaded links.

Figure 3-13: Five outside corner locations for threaded links.

11)  Screw a %”-20 nut down on top of the five threaded links from step 10) tightly. See
Figure 3-14.
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Figure 3-14: "4”-20 nut placement.

12)

Place a '4” ID rubber washer on top of each of the nuts from step 13). See Figure 3-
15.

|
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B

Figure 3-15: Rubber washer placement.
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13)  Cut a piece of sound absorbent foam to fit the area inside of the cover; the foam layer
can be cut small to maintain clearance. See Al.

14)  Peel the clear plastic backing off the sound foam and attach to the center of the
bottom of the fiberglass sound barrier panel; add layers if space is available. See

Figure 3-16.

Figure 3-16: Sound absorbent foam place underneath barrier panel.

15)  Place the sound barrier panel on top of the assembled parts from earlier, aligning it to

the five outside corner threaded links. See Figure 3-17.
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Figure 3-17: Sound barrier panel located on top of prior assembly

16)  Place five more 4 ID rubber washers on the threaded links. See Figure 3-18.

Figure 3-18: %4” ID rubber washer placed on threaded link.
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17)  Screw five more "4”-20 nuts on top of the rubber washers from step 16) to a tight fit.

See Figure 3-19 and Figure -20.

Figure 3-19: %4”-20 nut locations.

Figure 3-20: Final assembly viewed from the top.

18



4

4.1

4.1.1

Software and Hardware Interface Instructions

Data Physics Signal Force Shaker Table

Hardware Setup

Abacus (Data Acquisition Computer) (Data Physics DP700 Abacus Lite):

1)
2)
3)
4)
5)

Figure 4-1: Abacus data acquisition system

Flip the I/O switch in the back to the " I " position.

The “RED STOP” switch should be plugged into the “T2” BNC port on the Abacus.
Plug monitor into the VGA port on the Abacus.

The mouse plugs into one of the USB ports.

The keyboard plugs into the serial port in the front (located to the left of the USB

ports).
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Amplifier (DSA1 Power Amplifier from Data Physics, part of the Signal Force system):

1) Make sure the "Gain" knob on the amplifier is turned fully counter clockwise.

2) The black switch marked “INTERNAL/EXTERNAL” should be flipped to the
internal side.

3) Located on the back of the amplifier is a jack labeled "SIGNAL INPUT"; connect a
T-adapter F/M/F BNC adapter to this jack.

4) From the BNC adapter in step 3), run one wire from the adapter to channel 1 on the
Abacus machine, and the other port on the adapter is run into the “OUT 1” port on the

Abacus machine; this sets the machine up to run in a closed loop mode.

Sound Level Meter (Extech 407730):

Figure 4-2: Extech sound level meter

1) Connect a BNC to RCA adapter to a RCA to 2.5mm adapter.

2) Secure the meter at least 6-10 inches above the shaker table
3) Run a BNC cable from the adapters on the sound level meter to channel 2 on the
Abacus.
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Shaker Table (Data Physics Signal Force Unit):

1)

2)
3)

4)

5)

Figure 4-3: V300 Mechanical Shaker

Attach object to be tested onto the shaker table using M9 screws; four M9's were used
to attach both the project’s scale model and the cantilever beam.

Turn the amplifier unit to the ON position using the key.

Check the air inlets and make sure nothing is obstructing them and that the fans are
on.

Once the “POWER DC” and “COOLING” lights illuminate, push the opaque
“START” button in and hold for 5 seconds; the start button should stay lit.

One the power is turned on, the field becomes energized and the shaker becomes a
powerful magnet. Care should be taken to ensure that magnetic materials cannot come

into contact with the coil or annular gap.

Notice the ILS lights on the bottom left side of the shaker table. They are labeled
“HIGH”, “NULL” and “LOW”. The “NULL” light must be lit green. If it is reading
“LOW?, add pressure to the “ISOLATION” port using an air pump. If it is in the
“HIGH” position, bleed pressure from the “ISOLATION” port.
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4.1.2  Software Setup (Signal Star)

% Before any test begins, hearing protection must be worn by any person in the vicinity

Amplifier Pre-Setup:

1)

2)
3)

of the shaker due to the generation of high noise levels.

The amplifier should be in the “ON” position with the “GAIN” knob turned fully
counter clockwise and the switch on the “INTERNAL” side.

Turn “GAIN” knob until the Current is about 16%.

Switch to “EXTERNAL”; the shaker table should NOT be moving at this time and
the Current should drop back down to 0%.

Signal Star Software Setup (how to run a “Sine” test):

1)

Click the icon on the Desktop labeled “SignalStar Scalar”; it will open up and connect

to the Abacus. See Figure 4-4.

g Location: C:\SignalStariScalar\DuiProgram

Recycle Bin

A&'
td

Adobe Reader
Q)

=

Acrobaticon RealDats

Figure 4-4: Screenshot of application icon
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2) Click the white piece of paper to open up a new test.
3) Select “SINE” and click “NEW”. See Figure 4-5.

O SignalStar Scalar Vibration Controller
ETest Yew Hep lData Physics

Q New Test

Test Template:

<Defaulty

Exit New Test dialog with the selected test as the template,

Ready

Figure 4-5: Screenshot for starting a new test

4) Name your test.
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5) Click the computer icon labeled “TEST SETUP”; this window will remain open for
all the tabs mentioned in steps 6) through 15). See Figure 4-6.

= SignalStar Scalar Sine Contro

Test Edit Control Display Se
D E& ] = &

Elapsed Rernaining

Test: m

] Statie | 1evel |

Figure 4-6: Screenshot of the “Test Setup” icon

6) Under the TEST tab set the units as follows:
Displacement: CM
Velocity: CM/S
Acceleration: G

See Figure 4-7.

24



P Scalar Sine Vibration -- C:\SignalStar\Scalar\test\OperationsManual.svc

13 Oulputs] [w Inputsl Controll a Proﬁlel Run Schedulel

Run Increment: | Query M

Test Title: Run Notes
[Defauit Sine Tes! [ Enable Run Notes
Test Description: Prompt Response
L]
2]
L]
Run D L&
RunNane: | L2]
un Name: 5]
Li|
L]

[nits

. . Comments:
Displacement; | in v

Velocity: |in/s v
Acceleration: |g v

1§ Apply Help

Figure 4-7: Screenshot of the Test Setup menu

7) Under the “OUTPUTS” tab the only thing to be seen is the object’s mass properties.
“DUT” 1is the object subjected to the test, and “FIXTURE” is the mass of any
apparatus used to attach the object to the shaker such as adapter plates. Everything
else in this tab can be left alone.

8) If a sound level meter is being used, a unit designation needs to added into the system
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for Pa. Go to C:\SignalStar\Scalar\Units and open the “UNITS.TXT”. In this file, add
the following line at the bottom of the text file in an empty row. After the line has

been placed in the text file, save it and exit that folder. See Figure 4-8.

!Prot Default Type Label Scale Offset DB _coeff
"1 1 15 Pa 1 0 0"

B units - Notepad Q@@

File Edit Format View Help
1 0 9 pC 1E-12 0 0 A
1 1 10 A 1 0 0
1 0 10 mA 0.001 0 0
1 0 10 A 0. 000001 0 0
1 1 11 v 1 0 0]
1 0 11 mv 0.001 0 0
1 0 11 MV 0. 000001 0 0
1 1 12 HZ 1 0 0]
1 0 12 kHz 1000 0 0
1 1 13 K 1 0 0
1 0 13 ‘C 1 273.16 0
1 0 13 °F 0.55556 255,37 0
1 1 14 rad/s 6. 283185 0 0]
1 0 14 rps 1 0 0]
1 0 14 rom 0. 016667 0 Q
1 0 15 nar 1E+5 0 0
1 0 15 hhar 1E+7 0 0
1 0 15 N/m? 1 0 0]
1 0 15 N/cm? 1E+4 0 0
1 0 15 N,/mm? 1E+6 0 0
1 0 15 psi 6894, 8399 0 0]
1 0 1 (g)¥¥2/Hz 96,2361 0 0 2
1 0 16 m.Hz 1 0 0
v
< >

Figure 4-9: Screenshot of the “units.txt” file

9) Click the “INPUTS” tab in the Signal Star Scalar “TEST SETUP” window. Make
sure only channel 1 and 2 have an X in them. On Channel 1 make sure the “EU” is
"g" and “Range EU” is set to “10”. On channel 2 the “EU” should be set to Pa,
“Range EU” should be set to “10” and “Coupling” should be set to “DC SE”. See
Figure 4-10.
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0p|Scalar Sine Vibration -- C:\SignalStariScalarMest\OperationsManual.svc

Run Schedule I

@ Testl =1 Outputs e Controll L& Profile

@ Front End I @ Info|

Chz Activel Type | Hame | Mode | mV/EU I EU | Range(EU) | ARF | Weight | Coupling Class Serial = | &
1 [ Cortrol Cortrol RMS 100 g 10.000 OFF 1 ACSE Manual  N&
2 ] Measure Channel2 RMS 100 Pa 10.000 OFF 1 DC SE Manual  NA
3 [:| Measure Channel3 RMS 100 g 100.000 OFF 1 ACSE Manual — N/A
4 |:| Measure  Channel4 RMS 100 g 100.000 OFF 1 ACSE Manual  NA

Figure 4-10: Screenshot of the Inputs portion of the Test Setup menu

10)  In the “INPUTS” tab click “INFO” and “Direction” on channel 1 to “+Y” and

“Direction” on channel 2 to “+Y”. See Figure 4-11.

dp|Scalar Sine Vibration -- C:\SignalStar\Scalaritest\OperationsManual.svc

& Testl = Outputs Control| \~ Profile' Run Schedule]

@ FrontEnd @ Info

Ch= AﬂiVI Type Hame I Location I Direction I
1 Control  Control 0 +Y
2 | [ Measure Channel2 0 v
3 [[] Measure Channel3 0 +¥
4 | [] Measure Channel4 0 +X

Figure 4-11: Screenshot of the Inputs portion of the Test Setup menu
11)  Click the “CONTROL” tab and make the following changes: change the “Sweep

Mode” to “Linear (Hz/sec)”, set “Points/Sweep” to “8192”, and set ‘“Meas. Freq.

Ratio” to “11” to obtain the maximum sampling rate. See Figure 4-12.
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0p|Scalar Sine Vibration -- C:\SignalStar\Scalaritest\OperationsManual.svc

@ Tesll = Elutputsl [ Inputs \/~ Profile Run Schedule

Control Parameters PreTest

Multi-Channel Mode: | Single | Signal Type: | Unifom Random v |
Startup: |Pretest -l
Startup Time (sec): |4

Signal/Noise(dB): |3

Startup Level [dB): |12
g = | Safe Max Volts: |0.3

Shutdown Time [sec): |1

Start Level(dB): I-S
Sweep Mode: |Linear[H2a’Sec] ﬂ

Points/Sweep: |81 92

Averages: |1 0

Frequency Lines: |7[]l]

Meas. Freq. Ratio: |11

Check ICP: [
Filter Type: i . .
s IPropomonaI LI Skip Stop Switch Test: [
Bandwidth (%): |100.000 | Pause at end: Opt...
Sweep Parameters
Min Freq Max Freq Rate . L Min Level

Ho. (Hz) 7 (Hz) 7 (Hz'Sec) Duration | Mag. Sen. ,H Pamclpatlonr (EU) | Abort Sen. |
1 10 2100 4 966995 000:07:01 25 0 0.005 1

Add' Insert‘ Deletel

Figure 4-12: Screenshot of the Control portion of the Test Setup menu

12)  Go down to the “Sweep Parameters” section in the “CONTROL” tab; set the
minimum frequency to nothing lower than 5 Hz or error might occur.

13)  Click the “PROFILE” tab; under the Profile section and to the right is all the
parameters. Click EDIT and this will show the frequency sweep broken down in three
parts: the beginning frequency, a median, and the ending frequency. Altering “Ref” in
the 2nd and 3rd rows (median and ending frequency) will determine the ramp up. Do
not ramp up to the full amplitude too soon because the test will fail. The amplifier
needs time to get up to full amplitude. The actual number is in g's and determines the
amplitude the test will run at. 2.5g is the max amplitude the project’s tests were run

at. See Figure 4-13 and Figure 4-14.
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0p|Scalar Sine Vibration -- C:\SignalStar\Scalaritest\OperationsManual.svc

|~ Reference I

£7] Testl = Uutpulsl |} Inputsl Controlml Run Schedule

Profile

1.00

LogMag, g

20.0m

100mp-—~

L L ——l———— 1 1

10.0

100 1.00Kk
Hz

Acceleration (g peak]: 1.000
Velocity (in/s peak): 1.383
Displacement (in peak]: 0.005

| Edit .. |

[Edit current reference

Figure 4-13: Screenshot of the Profile portion of the Test Setup menu
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Profile Editor -- C:\SignalStar\Scalaritest\OperationsManual.svc\Profiles\Reference.rsi

e
//
1.00 |
o B .
=) N
g S
> / /
9 100mE———
> '
200m 1 1 1 1 1 L1 1 1 1 1 1 1 Ll
10.0 100 1.00k
Hz
Profile T able
Profile Format : |Table v _I
I Freq | Ref | Unit | Type [Alarm Low| Alarm High |Abort Low| Abort High
1 [10 0.01 in CD -3 3 -6 B
2 |44.234 2.5| g CA -3 3 -6 6
3 [2100 25 g CA -3 3 -6 6

|Enter 0in Freq{Hz) column for automatically calculating crossover frequency|

Add | Insert I Delete | Displacement: | Acceleration (g peak): 1.00033
Velocity (in/s peak]: 1.38941

Limit Spec: |dB :l' Displacement (in peak): 0.00500
Save s | Apply | | 0K | Cancel

Figure 4-14: Screenshot of the Profile Editor menu

14)  Click the “RUN SCHEDULE’ tab and setup for either a “SWEEP” or “DWELL” test.
A sweep runs a test from the beginning frequency chosen to the ending frequency in
steps of 5 hz/sec or whatever the chosen rate is in the “CONTROL” tab. A “DWELL”
runs a tests at a magnitude for a specific amount of time at certain frequency. Again
choose too low of a frequency, less than SHz, and errors will occur with the dwell

test.

30



Setting up a Dwell: Under the “COMMAND” column click the word “Full Sweep”
and it should open a drop down menu; select “DWELL out of the choices.
Under the “DURATION TYPE” column click the word “CYCLES” and select
“TIME” instead. Set your time and frequency. See Figure 4-15.

0P Scalar Sine Vibration -- C:\SignalStar\ScalarMest\OperationsManual.svc

7] Test] = Dulputsl [ Inpulsl Controll Vel . RunSchedule |
| Command I Freq | Duration Type | Duration |
_|Dwel| 10.00 Time 000:07:30

Add |

Dwell at frequency 10.00 Hz for 000:07:30

Delete |

Figure 4-15: Screenshot to change the Run Schedule to a Dwell

Setting up a Sweep: Under the “COMMAND” column select “SWEEP”; set the start
and stop frequency (they must be within range of what is set in the
“CONTROL” and “PROFILE” tab). “DURATION TYPE” should be set to
“TIME”. Look back into the “CONTROL” tab and look at the time duration
for a full test; set the time duration in the run schedule to be about 20 seconds
longer and 10-20 Hz shorter so there is time to stop the test. Make sure to set

“SAVE INTERVAL” to “EVERY 1 SWEEP”. See Figure 4-16.
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0p|Scalar Sine Vibration -- C:\SignalStar\Scalartest\OperationsManual.svc

4 Test| = Outputs | I Inputs | E& Control | |5 Profile FEIIGI Schedule‘

| Command |Stan Freql Stop Freql Duration Type | Duration I Save Interval

JSWeep 10.00 2100 Time 000:07:30 Last

Sweep from 10.00 Hz to 2100.00 Hz, 000:07:30, save on last sweep

4dd | Delete |

Figure 4-16: Screenshot to change the Run Schedule to a Sweep

15)  Click “APPLY” then “OK” once all the tabs have been setup.
16)  Click “DISPLAY” at the top toolbar; select “NEW GRAPH”. See Figure 4-17.

L) SignalStar Scalar Sine Controller - C:\SignalStar\Scalar\test\0peratif

Test Edit Control | Display | Setup Report View Window Help

DeE & & W Layout Manager... . W@ L m e
: Status iiEl Mew Graph... i
Elapsed R Graph attributes... m - 1

Stage: m n Copy Attributes
r

] Status | Level | L. Graph Controls /)
LR e e | ~r l' E' l— -

Figure 4-17: Screenshot of configuring a new graph
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17)  Under “SX-Spectrum” select S2 (this is the channel 2 for the sound pressure); click
“OK” and this will bring up the graph. See Figure 4-18.

0P Select Signals @

Signals / Graph
Display Mode (& Nomal O QO Spreadsheet ,7

+

Control & Signal Axis | Run  Save Test
K - Time Signal 52 L
X1
X2
S - Spectrum
51
Transfer Function
Limit Channels
Pretest Data
=X [p) - Time Data
X1 (p)
%2 (p)
- S« [p] - Spectrum
S1(p)
52(p)
=1 Hzy (p) - Transfer Function
H Drive,1 [p)
H Drive,2 [p)
=1 Coh [p) - Coherence
Coh1 [p] v < >

Graph Template: |Default L] Bmwsel Apply | Cancel| | oK |

Figure 4-18: Screenshot to select preferred data

18)  Click “DISPLAY” at the top toolbar again and then select “GRAPH CONTROLS”.
Make sure both buttons are on “LIN” and not “LOG” for the X and Y axes.
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Running and Saving a Test:
1) Make sure the sound pressure level meter is turned on.
2) Click the “INIT: button in the Signal Star Scalar program (it is dark green). See

Figure 4-18.

& SignalStar Scalar Sine Controller - [S2]

@ Test Edit Control Display Setup Report View Window Help

DSHSEG & 1| = Blcomwdone - W @[L]D = B E AN

: Status X | ! =
- e 1.000
Elapsed  Remaining ; = [
]Status |Level I i3
: Control x| B
- End :'v. ] o © I
J 0N | = 0.500F
1 L0G [{E
, = o
i 0 1 1 1 I 1 1 1 I 1 1 1 l 1 1 1 I 1 1 1 l 1 ]
SERLNRAR 200.0 400.0 600.0 800.0 1000.0
Auto ¥ Hz
Ao o[ ON | Loc (RS

Figure 4-18: Screenshot of main testing screen
3) Click “YES” for overwriting last run.

4) A message, see Figure 4-19, will pop up alerting the operator to push the “STOP”
button (the red button plugged into T2 on the Abacus); press it.
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Stop Switch System Check @

Press STOP switch to acknowledge.

Cancel

Figure 4-19: Pop up message to press “STOP” button

5) Click “START” after the "Ready to start" message appears in the control prompt; it is
located under the big green “START” button. See Figure 4-20.

: Control X

Resume

Ready to Start

Figure 4-20: Screenshot indicating the “START” button and control prompt message

6) After the Pre-Test runs, click "Start Test" in the “Pretest Report” window when it
appears. See Figure 4-21.
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Pretest Report Q’EHX‘

PRETEST REPORT :

Test: OperationsHManual.svc
Date: 86 April 2009

Time: 02:00:00 PH

Status: PASS

Averages: 10

Min Signal/Noise: 9.0 dB ,
Max Safe Drive Uolts: 8.3680 U
Drive Uolts: 8.186 U

Channel Noise {(mU) Level (mU) Level (EU) S/N (dB) Status
1 8.133 26.073 8.261 45.9 (1]
2 8.615 8.0835 0.06006 7.5 Open (S/n)

Add Avg Start Test Abort

Figure 4-21: Screenshot of a “Pretest Report”

7) The test will run, and make sure to hit “STOP” after it reaches the desired max

frequency. If not, the test may not save the data correctly and error will occur.
8) Right click the graph and scroll down to “GRAPH” and select “EXPORT”. This will

save a raw file of all the data points. See Figure 4-22.
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Signal Select

Graph Attributes
Documentation Window
Annotation

Auto Scale (XY) | |
I | | | I 1 1 1 1

000 1200, SUr 8000 2000.0
iz Cursor Edit

B Markers . pepoaarng
.~ Zoom | S * l@ 24 |
———— ] e '

Clear

Copy

Paste 4
Save Template
Print
Export

"y Y VvV Vv Vv

T e |

Figure 4-22: Screenshot of scroll down menu to graph

9) If a copy of the graph that appears in the screen is desired for reference, click the
down arrow next to the printer symbol and select the two papers icon located at the
bottom right of the graph. This will copy the image of the graph to the clipboard. For
example, paste this in WordPad and save. See Figure 2-23.

Copy to clipboard
Figure 4-23: Screenshot of icons to copy graphs

Shutting Down:

1) Click “END” in the control prompt and save the test; select “TEST” from the top
toolbar and go to “EXIT”.

2) Hold the “STOP” button on the amplifier for about 5 seconds.

3) Turn the “GAIN” knob full counter clockwise.

4) Switch the “INTERNAL/EXTERNAL” switch over to “INTERNAL”.
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5) Turn the key to the “OFF” position.

6) Shut down the Abacus system by going to “START” on the desktop and selecting
“TURN OFF COMPUTER”.

7) Select “Turn OFF”. The computer will shut down like normal.

8) When the monitor goes black, flip the “I/O” switch in the back to the “O” position.

9) Turn off the monitor using the power button on the front.

10)  Unplug the three-prong power cable from the wall that is connected to the amplifier

for safety.
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4.2

4.2.1

dSpace, Matlab, and the PiezoMechanik Amplifier

Hardware Setup

Amplifier (PiezoMehcanik)

1)

2)

3)

4)

5)

‘ -/ ;

2 2
HV

L

Figure 4-24: PiezoMechanick Power Amplifier

Unscrew the fuse, labeled “F3” on amplifier, and check to see if it is blown. See
Figure 4-25.

To connect voltage input signal into amplifier, use a BNC cable from the source and
connect the other end to the “MOD IN” input channel. See Figure 4-25.

To connect piezo materials to amplifier, plug the associated Lemo connector from the
piezo actuator to the port “PIEZO”. See Figure 4-25.

To turn power amplifier on, flip the green “POWER” switch to the “I” position. See
Figure 4-25.

To adjust the voltage bias of the system, adjust the “Ushift 2At” knob. See Figure 4-
25.
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6)

Check the voltage output by viewing the LED display screen located above the two
BNC ports. See Figure 4-25.

7)

Figure 4-25: Close up view of control of the PiezoMechanik

To turn power amplifier off, flip the green “POWER” switch to the off position.

Data Acquisition (dSpace)

1)

2)

3)

4)

Connect the dSpace unit to the associated computer by using the dSpace PCI card and
connecting cables.

Make sure either the yellow fiber optic cable or the Ethernet like cable is used to
connect the dSpace and computer system.

Connect external devices such as capacitor probes and LVDTs using BNC cables to
the data acquisition port board.

To turn dSpace on or off, flip the green power switch to the on or off position.
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4.2.2 Software Setup

Matlab and Simulink (Control Code Source)

1) Open Matlab 6.5.1 by double clicking associated icon.
2) After Matlab loads, check the display in the “Command Window” and make sure the
dSpace configuration is “okay” and that the “RTI” and Simulink does not list any

errors. See Figure 4-26.

File Edit View Web Window Help

N3 ) 6 2 CurremDirectory:IC:WATLAEIBpS\work

= Stadc

This is a Classroom License for instructional use only.
Nane Size Bytes Class Research and commercial use is prohibited.

Using Toolbox Path Cache. Type "help toolbox_path_cache” for more info.

To get started, select "MATLAB Help” from the Help menu.

Configuring dSPACE Software for MATLAB 6.5.0.196271 {R13.0.1) ...

RTI Real-Time Interface to Simulink (RTI100S5) 4.4 17-Mar-2003 okay
DSSIMULINK ControlDesk to Simulink Interface 2.3 17-Mar-2003 okay
MLIB/MTRACE MATLAB-dSPACE Interface Libraries 4.4.6 17-Mar-2003 okay
MDES HotionDesk Blockset 1.1 17-Mar-2003 okay

dSPACE conficquration okay.

TIP: You have RTI relewvant MATLABE Toolboxes or Simulink Blocksets installed. You can get

Command History @@ information on RTI compatibility from http://www.dspace.de/goto?Toolboxes
load fregsweep_021609_blvl_Olhz_20hz_200s_01 ~
who
cle Some Simulink default parameters are unsuitable for use with RTI.
clear all It is recommended to change these defaults in the Simulink Preferences dialog.
load fregsweep_ 021609 _blwl 0lhz_20hz_200s_01
who - Solver page - current recommended setting
5-- 2/19/09 3:39 PM --% Simulation time
simulink Start time: " > oo
Stop time: v -> 'Inf'
%-- 2/25/09 7:01 PM --% Solver options
simulink Type: " > 'odel!
%-- 3/18/09 7:53 AM --% Fixed step size: v -> '<any numeric value>'
simulink
%-— 3718/09 2:11 PM --% - Advanced page - current recounended setting
simulink Block reduction: ‘on' -> ‘'off!
%-- 3/25/09 9:31 AM --%
simulink
%-- 3/27/09 4:23 PM --% >>
exut
%-- 3/30/09 6:11 PM --%
simulink
%-- 4/04/09 12:36 PM --%
simulink

%-- 4/08/09 1:54 PM --%

4\ Start | Ready

Figure 4-26: Screenshot of Matlab display window at startup
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3)

4)

Bytes Class Research and Select a new directory

Make sure the current directory is set to the correct folder containing the Simulink
files; this is where data will be saved from dSpace. See Figure 4-27.
To change the directory, press the icon that has three dots located next to the “Current

Directory:” scroll down menu and select correct folder. See Figure 4-27.

? | Current Directory: | C:\MATLABBpSwvork v E]

Browse For Folder @

This is a Cla

Using Toolbox P more

To get started, ) Graphs o
) joish

) MATLAB

=================| ) narrowband s====
Configuring dSPAC @Y Jarrowband 2 |

) New Folder

RTI Real ) Patents

DSSIMULINK Conj ) pictures v
MLIE/MTRACE MAT)
MDES Mot

Folder: Narrowband_2

dSPACE confiqurat]

[ Make MNew Folder ] [ OK ] [ Cancel ]

TIP: You hawve RTI relevant MATLAB Toolboxes or Simulink Blocksets ins
X information on RTI compatibility from http://www.dspace.de/goto?

Jlhz 20hz 200s 01 - e

5)

6)

7)

8)

Figure 4-27: Screenshot of the “Current Directory” menu

Open the Simulink file containing the control code necessary for testing by using the
“Open File” tab in the “File” menu.

The Simulink file should contain the associated dSpace blocks to have correct
instrumentation linkage for data analysis; use the Simulink toolbar by typing
“Simulink™ into the Matlab “Command Window” to add dSpace blocks and the like.
Turn dSpace on before the Simulink file is run by flipping the green on/off switch on
the dSpace unit.

Run the Simulink file by pressing the icon looks like a rectangle that has three arrows

pointing down on it. See Figure 4-28 and Figure 4-29.
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il narrowband_piezo B@

File Edit View Simulation Format Tools Help

DeEed& = = = » = Nomal YwE o RE T ®

RTI Data
S+2%pi
Kp S+2007pi

Kp DAC #1
DAL #2
Transfer Fen
DAC #3
- ="/-\ DAC #4
ref_signal2 T - e

Constant1 Gain3 Gain2 Saturation DAC #5

DAL #6
DS2102_B1

Constant
K Integrator

displace2

MUX_ADC » I » K<> Displacement

DS2002_B1 Gain1
C ) time »
Clock —
»—a
Constant2 Switch
-500
sound
Terminator
Ready 100% [ lodeS Y

Figure 4-28: Screenshot of a Simulink diagram

Format Tools Help

B2 2 » = Nomal || £ = S

/

Figure 4-29: Close up screenshot of the run icon
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9)

Messages should appear in the Matlab “Command Window” as the Simulink runs and

compiles; check for error messages and once the file is loaded, testing can commence.

dSpace Control Desk (Data acquisition runtime software)

1y
2)

3)
4)

Matlab/Simulink run independently from dSpace Control Desk. Unless data needs to

be collected or view in real-time, Control Desk does not need to be used.

Open dSpace Control Desk by double clicking the associated icon.

Check that there are no errors and that the RTI has loaded by viewing the commands
listed in the “Log Viewer”. See Figure 4-30.

Load an experiment by going to the “File” menu and selecting “Open Experiment.”
Select the correct experiment that is associated with the Simulink file loaded; the
dSpace Control Desk file is dependent on its corresponding Simulink file. See Figure

4-30.
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%. ControlDesk Developer Version

[@sm s me=cc 0 |naswn]mans = o@an]in x| ems|sa
|

Open Experiment E [XJ
Look in: |Ea Narrowband_2 j - £ B~ ‘ &

|)narrowband_piezo_leadlag2_rti1005 ) piezo_injector_rtil00s
|_)narrowband_piezo_rti1005 épiezo_narrowband
[)narrowband_piezov2_rti100s

()narrowband_vé_rti1005

(CINB July 1

()pi_piezo_rti1005

< Il

File name: | piezo_narowband Open I

Files of type: |I:onlroIDesk Experiment (*.cdx) ;l Cancel

[ ]
Preview >>

C&Ex. [Emn. =L

x| [Framework: Initializing Experiment. Component ~
_J|Framewark: Initializing HierarchyBrowser. Component b
Framework: Initializing Instrumentation. Component
Framework: Initializing ReferenceD ata.Component
Framework: Initializing SCOUT.Component
Platform: Connecting to the bus ... E
Platform: ... completed. r
Platform: Establishing the connection.
Framework: Initializing TrcParser.Component L
o™
T T Log Viewer £ Intery A _File Selector [/
For Help, press F1, EDIT | || num | |4/sfe009 13:57

Figure 4-30: Screenshot of the Control Desk window and “Open Experiment” window
5) Once the file has loaded, make any desired changes to the graphs and run by pressing

F5. Depending on what types of graphs and data displays are used, one should see

some activity in the graph windows. See Figure 4-31.
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1% piezo_injector - ControlDesk Developer Version - [layout1 *]

g File Edit View Tools Experiment Platform Instrumentation Parameter Editor ‘Window Help
[ =2 K2 Dy S8 W wm B @ EEE 40 £ @ H A
= = £ &

=] é piezo_injector
piezo_injector.cdc

H ' -2120
piezo_injector.cdd . |PF'E-piezo_iniecIor-HostSelvice j
D Ia}mut?.!ay Start | Settings... | | T
=1 pieza_injector.sdf B i
piezo_injector.map o I.,..,.. 100 % Length 4.98 2 a2
piezo_injector.ppc : L
piezo_injector.trc I Downsampling 2 E’Z %
=0 piezo_injector_t.sdf ! > 2160
piezo_injector_1.map ¢ IT i
piezo _!n!ector_l.ppc ! Level | a Delay | ] 5 2170
Iy piezo_injector_1.trc 0 i
_ o_injector.sdf i [<< Drop tigger vaiable here >> e
piezo_injector.map i~ Reference Capture Capture Variables -2190
piezo_injector.ppc W 004 of 004 ™ 0 1 2 3 4

piezo_injector.trc

Labels ref_signal
o N
s &
4
o
I

-2

Labels mixed1
- N W s
%

0
n 0 1 2 3 4
< >

& Expe... |§2Instr.. EHPiat.. B layoutt
| |SDF File Parser: .. successful ~
_l|DataKemel: WARNING The data connection is not valid.

ariable Browser: ... finished.

Real-Time Processor. [#1]ds1005 - RTI: Initializing ... (720)

Real-Time Processor. [#2] ds1005 - RTI: Initialization completed (721)

Real-Time Processor. [#3]ds1005 - RTI: Simulation state: RUN (700)

DataKernel: Starting the animation ...

DataKemel: WARNING The data connection is not valid.

DataKermnel: The animation is running.

v
Log Viewer A Interpreter A File Selector  c:\matlabBpSworkipieza_injector.sdf A c:\matlabBpSiwork\piezo_injector_1.sdf A c:\matlabBpSiwork\piezo_injectoripiezo_injector.sdf  /

For Help, press F1. RUN NUM 5/29j2008 12:19

Figure 4-31: Screenshot of graph activity

6) Make sure that the correct Simulink file name appears in the drop down menu located
above the “Start” button. See Figure 4-32.

7) To start and stop the simulation from running, click the “Start” button. See Figure 4-
32.

8) To change the length of time for each portion of testing and data collection, change
the value in the area next to “Length”. See Figure 4-32.

9) To collect data, make sure the desired “Capture Variables” have been loaded and
click the save button. To add a “Capture Variable,” the data recorded during the test,
drag the desired variable from menu under the “File Selector” tab at the bottom of the

screen to the small icon underneath the “Capture Variables™ area. See Figure 4-32.
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10)

11)

12)

13)

6)
=l x| /
: — , N Y
E IPF‘C - pieza_injector - HostService L] .
6) - > Start ‘ Settings... I ; e
) , Length| 49 €—— 7) i[5 2
' ' 1-)
‘ V2
i —Trigger Signal S o
w A0 i3
! 5
" ! Level 0 Delay 0 32
1 1) : |<< Drop trigger variable here >> -2
L : Reference Capture Capture Variables : 0y
P Take & 004 of 004 L
I n . - - . I

10) 9)
Figure 4-32: Screenshot for steps 6) — 11)

To save data, press the “Save” button and then a generic “Save as” window will
appear. See Figure 4-32.

Use the “Auto Repeat” option to select or unselect the data repeating over the span of
time chosen in “Length”. See Figure 4-32.

If the simulation runtime ends and another test run is desired, re-load the Simulink
file and then repeat step 5).

Once testing is completed, close the dSpace Control Desk window by selecting either

the “X” at the top of the window or “Exit” from the drop down “File” menu.
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5 Converting Raw Data

In order to record the sound power level emanating from the test bed during the tests
a sound level meter, see Figure 4-2, was used as the recording device. The sound level meter
used for testing displayed a digital reading in decibels (dB); however, the output signal to the
data acquisition system was in volts. It became apparent upon examining the data that the
meter had several 20dB ranges. This lead to the conclusion that each time the sound level
meter switched ranges the voltage reading started back at its base reading (between 0.5V and
1V) as displayed in Figure 5-1. Make notice of the sharp drops; these are the transitions

between ranges.

S2
Max:11.1
Min:578m

10.0 |~

@
o
o

|

.00 |~

;Magnitug’e, Pa

AL ) VA

0 | | | | | | | | |
200 400 600 800 1.00k 1.20k  1.40k 1.60kK 1.80k 2.00K
Hz

Figure 5-1: Raw data collected using sound level meter

The change in range is made evident by a very rapid change from a high voltage
reading between 9V and 11V to the base reading. Using information from the sound level
meter user manual, the company technical support team, and direct experimental comparison
with other meters, a linear relationship [dB= (2.582)(voltage out)+37.16] was determined to
convert from the voltage output to decibels. To compensate for the 20 dB range change,
20dB was added when the range shifted up and subtracted when the range shifted down.

Figure 5-2 below shows the converted data from figure 5-1 above.
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Figure 5-2: Analyzed data using method described
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Appendix Al: Pro-E Drawings

The following drawings are included as a reference for hole location, sizing, and part

reproduction.
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